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What’s new in Adobe Photoshop CS

P hotoshop CS offers a wealth of features that
will truly be of benefit to photographers
everywhere. In this first chapter I am going to
give a you a quick run through all the new

major features that will be of interest to photographers. If
you are a Macintosh user Photoshop CS will only run using
Mac OS X 10.2.4 or later (10.2.6 or 10.3 is recommended),
and only  a G3, G4 or G5 computer. If you are using a PC,
you will need to use Windows 2000 (with Service pack 2)
or Windows XP operating systems running on an Intel
Pentium class III or 4 processor.
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Custom Keyboard Shortcuts
For some time now, just about every keyboard shortcut
combination shortcut in Photoshop has been exhausted.
Furthermore, the keyboards in some countries differ quite
significantly from the standard US English keyboard
design, sometimes missing keys such as the tilde (~) on the
computer keyboard. In the past, because of these
restrictions, not all language users are able to make the full
use of the program. And not everyone has the same
priorities and objectives when using Photoshop. With the
Keyboard Shortcuts editing dialog, you can now decide
which keyboard shortcuts you want to use to call specific
Photoshop actions and save these as custom shortcut sets.

File Browser and Camera Raw
The first thing you will notice about the File Browser is
that it is no longer a dockable palette. The File Browser is
opened and closed by clicking a button on the Tool Options
bar. The File Browser operating speed is noticeably faster
in Macintosh OS X 10.2 and the Camera Raw plug-in is
fully integrated, including updates for the latest raw camera
file formats. Many existing customers will have already
purchased the Camera Raw plug-in for Photoshop 7.0. And
to my mind, this is one of the most useful productivity
plug-ins for Photoshop that has ever been built. Using
Camera Raw is like injecting rocket fuel into your digital
capture work flow, because it enables you to shoot raw
captures with your digital camera and process the data in
Photoshop at a much faster speed compared to the software
supplied with most of today’s digital cameras. The knock-
on effect of the Camera Raw plug-in has made a huge
difference to the way photographers are able to process
their capture files and make full use of the high quality of a
raw file compared to shooting in JPEG mode.

The image file management in the File Browser has
been improved. Images can be flagged and this provides a
nice simple way in which to designate the pictures you like
best. Using the Thumbnail View options, you can then hide
all unflagged images, making it easier to conduct the image

Editing metadata
Certain metadata information is editable
within the File Browser, so you can edit the
File Info text entries, add keywords and
conduct metadata or keyword searches, all
from within the browser interface. An edit
history log can be kept as you edit an
image. This can be saved within the
metadata or as a separate log file.

Improved Mac OS X performance
When Apple released the Mac OS X 10.2
update (code name: Jaguar), a number of
Mac OS X users experienced terrible
crashing problems when using the File
Browser. Initially the problem was fixed
with a free plug-in patch for Photoshop
7.0, but now Photoshop CS runs more
smoothly and faster in Mac OS X 10.2.

Figure 1.1 The Keyboard Shortcuts dialog.

Quick folder access
You can get the File Browser to target on a
folder by dragging the folder from the Mac
OS X Finder or from the Windows Explorer
to the File Browser Preview pane.
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Figure 1.2 The layout of the new improved
File Browser can easily be customized to suit the
way you work. The panes on the left hand side
can be rearranged any way you like and the
preview pane can be scaled to display larger,
rendered previews. A custom size can be set for
the Thumbnails which makes it possible to
compare images side-by-side more easily.

Figure 1.3 The Camera Raw plug-in enables
you to process raw camera file images and open
them directly in Photoshop. The revised interface
also contains extra controls for advanced users,
providing greater control over the image color
and the ability to suppress noise and other
camera file artifacts.

selection process. Folder navigation is made easier too. The
folder menu allows you to quickly access recently visited
folders and assign favorite folders. The File Browser has its
own menu which among other things, allows you to run
automation routines within the Browser interface directly.

Backward compatibility options
You can save files with the ‘Maximize
Backward Compatibility’ option set to
Never in the General Photoshop
preferences and not keep being bugged by
a warning dialog every time you come to
save a layered image.
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Extended 16 Bit support
The Camera Raw plug-in takes full advantage of the fact
that most digital cameras are capable of capturing a greater
tonal depth than 8-bits per channel. And many
photographers prefer to scan their originals using 16-bits
per channel mode. Over the years, the number of
Photoshop features that will work in 16-bit mode have
increased. Now for the first time, you can use tools such as
the brush tool and history brush in 16-bit. Even more
importantly, you can add image and adjustment layers as
well. The image bit depth is always indicated in the title bar
just after the color mode. For example, the document status
title bar may show: CMYK/8 or RGB/16.

Live Histogram palette
The new Histogram palette provides a live histogram of the
image or the active selection contents. This is especially
useful if you wish to view graphical feedback of the Levels
histogram when making any type of image adjustment (not
just Levels), such as when making a Curves adjustment.
The Histogram palette can display the composite channel
information along with an expanded view of the individual
color channels, or a luminosity histogram (as used to be
displayed in the Image menu Histogram). This latter mode
is preferable for accurate image assessment. And lastly, a
color histogram bar mode, like the one you see in the
Camera Raw dialog.

Interface changes
The first thing you will see When launching Photoshop CS
is the Welcome screen. Use this to access the latest
information about what is new in the program, learn about
hot new tips and access the latest Photoshop tutorials
which are available on-line.

The canvas area has been extended. If you are using
one of the full screen viewing modes, you can scroll the
image beyond the limits of the document bounds. This is
particularly useful if you are viewing a large image at an
Actual Pixels display view but the Photoshop palettes are

Figure 1.5 The Histogram palette.

Figure 1.6 The Photoshop CS Welcome
splash screen.

Figure 1.4 Photoshop CS provides extended
features for images in 16-bit per channel mode.
The bit depth is always indicated in the document
window status/title bar
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obscuring part of the picture and you want to draw a pen
path that extends outside of the image area.

As before, you can use the Window ➭ Arrange menu to
force all open image documents to display in a cascade or
tiled view. In Photoshop CS you can now hold down the
Shift key to apply zooming and scrolling simultaneously to
all open documents. And if you thought the previous
30,000 pixel limit was too limiting, this has been raised to
300,000. However, there is still a 4 GB cap on the size of
file that can be saved using TIFF and 2 GB for the native
Photoshop file format. If you need to save a larger image,
you can do so by enabling the new PSB file format in the
general preferences.

Image Adjustments
Photoshop CS offers some useful new image adjustment
tools. The Shadow/Highlight Correction can be simply
described as an image adjustment that can be used to
selectively bring out detail that was otherwise hidden, such
as in images that have heavy shadow areas or where the
highlights appear to be almost completely blown out. This
adjustment tool can apply a shadow or highlight correction
but without affecting the contrast in the midtone areas. The
Match Color adjustment enables you to match the color
and tonal range between two images. This works
exceptionally well if you have a series of almost identical
looking pictures, but where the white balance of the
lighting has maybe shifted a little and you want the
appearance to match, such as a portrait series shot under
changing lighting conditions.

The Photo Filter adjustments simulate the Kodak
Wratten™ series of photographic filters. Applying one of
these image adjustments is just like adding a Kodak™
color correcting filter over the lens at the post-production
stage. You can warm or cool the colors in your photos or
color correct pictures that were photographed using the
wrong white balance setting, the same way as using the
white balance controls in the Camera Raw dialog.

Figure 1.7 The extended canvas area allows
you to work up close without having palettes get
in the way.

Figure 1.8 The Shadow/Highlight Correction
adjustment can be used as shown here, to lighten
the shadows and darken the highlights, to produce
an improved full tone image. The advanced options
provide even more subtle control.
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Figure 1.9     The Photo Filter image adjustment can replicate in
Photoshop the effect of adding a colored camera filter over the
lens. The naming scheme used matches the Kodak Wratten color
correction camera filters. So if the image you are editing looks too
cool, you can use the 85 filter setting in Photoshop to ‘warm up’
the picture.

Figure 1.10 If you have a series of
photographs where you wish to make the colors
all match, then the Match Color image
adjustment can be used to select a sample
image, sample the colors and apply as an image
adjustment to another photograph. This
adjustment tool can also work using selections
from a sample image, or a separate layer in the
same picture. In this example the photograph on
the right shows a split view of before and after
where this image was made to match the color of
the one on the left.
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Image interpolation
Photoshop CS provides two new interpolation options that
will produce better results when you increase or decrease
the number of pixels in an image. Bicubic Smoother will
produce smoother results when enlarging an image and
Bicubic Sharper will preserve more detail when you reduce
an image in size. These interpolation methods will produce
results as good as if not better than using what was known
as the ‘step interpolation’ method, and more quickly too.

Filters
The Photoshop Effects filters namely the Artistic, Brush
Strokes, Distort, Sketch, Stylize and Texturize series, can
all be accessed via a single dialog in the Filter menu called
the Filter Gallery, which is shown in Figure 1.12 Instead of
trying out one filter after another, you can use the Filter
Gallery to quickly compare the outcome of using different
filter effects. And as you try out different filters, the
individual effect settings are stored in the dialog’s history.

The Fibers filter is new. It is located in the Filter ➭
Render menu and can be used to generate natural fiber
texture effects. The Lens Blur filter is also new and can be
used to simulate camera lens blur and is capable of making

Figure 1.11 The Filter Gallery dialog makes it
easier to navigate the Photoshop special effects
filters and compare the outcome of the various
filters more quickly using the filter history
section.

Figure 1.12 The new Fibers filter dialog.

Hard Mix blending mode
The new Hard Mix blending mode
produces a posterized image consisting of
up to eight colors: red, green, blue, cyan,
magenta, yellow, black and white. The
blend color is a product of the base color
and the luminosity of the blend layer.

Scrubby sliders
You can change the unit values for a
numeric field by C L clicking and
dragging the ‘scrubby slider’ cursor to the
left or right. If the field label has a name,
you can simply mouse-down over the label
name and drag. Holding down the S
key at the same time will make the units
change ten times faster and holding down
the O A key will change them ten
times more slowly.
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Figure 1.14 The Liquify dialog interface has
been updated to provide improved brush setting
controls, masking and backdrop viewing options.

Figure 1.13     The Lens Blur filter has a range
of controls that enable you to simulate the blur
produced when something is photographed out
of focus. The results this filter produces are more
convincing than the simple gaussian blur. You
can also use a variable density layer mask to
govern the focal blur amount.

a background look realistically out of focus. This is
achieved by accentuating flare from the brightest highlights
and producing iris-shaped highlights. And you can use the
transparency of a layer that is being filtered to create a
graduated focus effect.

Extracting textures
The Extract command features a textured
image mode which utilizes the image
texture as well as the color to calculate an
image extraction. This can come in handy
when there is a contrast between the
texture of the subject and that of the
background you want to cut out from.
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Layer management
The Layer Comps palette can help you organize your layers
by saving the layer visibility configurations. This feature
can have many applications, but will be particularly useful
to web page designers who very often work with lots of
layers and who need to quickly switch between different
layer visibility settings. With layer sets you can now create
new sets by dragging linked layers to the layer set button in
the Layers palette. And layer sets can also now be nested
within Layer Sets, up to five levels deep.

Automation
Several new changes have been made to the Automate
plug-ins (located under the File ➭ Automate menu). Most
of the Automate plug-ins can also be accessed via the File
Browser Automate menu and applied directly to selected
images in the File Browser.

The Crop and Straighten Automate plug-in will neatly
auto-extract single or multiple images from a scanned
image, like the example shown in Figure 1.16, applying
rotation as necessary and automatically cropping to the
edges of the picture.

 There are many applications that can be used to create
slide shows (such as iPhoto). The new PDF Presentation
feature will enable you to produce a simple self-contained
PDF format slide shows of selected images which can
incorporate a variety of image dissolve effects. PDF
Presentation files will work best with Acrobat 6 and the
latest Acrobat Reader programs. They will be able to
activate special features such as ‘Picture Tasks’, that allow
operations to be done on each image individually, such as
ordering prints and uploading images to other picture
services, etc. As a professional tool it is unfortunately
somewhat limited, but nonetheless it has interesting
potential for the future.

Photomerge was first introduced in Adobe Photoshop
Elements and has now been included with Photoshop CS.
This new version of Photomerge has none of the file size
restrictions that were associated with Photoshop Elements.

Figure 1.16 You can use the Crop and
Straighten Photos automate plug-in to
automatically prepare scanned images that need
to be cropped and rotated. In this example, two
photographs were scanned at the same time. The
Crop and Straighten Photos command will
extract both images, rotating and trimming them
and preparing them ready for you to edit.

Figure 1.15 The Layer Comps palette and
New Layer Comps dialog.
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Figure 1.17     The Photomerge plug-in first
appeared in Photoshop Elements 1.0. Now for the
first time, it is included in Photoshop CS and
robust enough to allow you to make quite large
composite files compared to the limitations of the
Elements version of this plug-in. You also have
the facility to save a Photomerge document with
the layers preserved. This makes the plug-in
even more versatile to use.

It features a ‘Make Layered Image Only’ option, which
means you can use Photomerge to align multiple exposures
of the same image. For example, if you want to align and
merge two or more almost identical exposures, Photomerge
will automatically take care of the alignment and produce a
layered document for you.

The image spacing in Contact Sheet II is more
efficiently designed. It can be set manually to tighten up
the gaps in your contact sheets quite considerably. The
spacing is improved even when the Auto spacing option is
selected. Picture Package features a new layout editing

Figure 1.18     The Horizontal Feedback template
is one of several new templates that are used
with the Web Photo Gallery. The page shown
here includes a feedback form that will enable
visitors to the gallery site email picture selections
and any comments back to you.

On-line Services
The Automate menu hosts on-line
services, which will enable you to access
external services such as a remote printing
service, like ‘Shutterfly’, directly without
leaving Photoshop.
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dialog with an easy-to-use interface. Designing your own
custom Picture Package layouts has never been simpler.
The Web Photo Gallery has a completely new set of web
gallery templates. Figure 1.18 shows an example of a website
created using the Horizontal Feedback template. Examples of
the other new templates can be seen in Chapter Fifteen.

A small selection of JavaScripts can be accessed via the
File ➭ Scripts menu. More scripts can be added to the
Adobe Photoshop CS\Presets\Scripts\ folder. Ready made
Scripts can be found on the Adobe Studio Exchange
website at: <http://share.studio.adobe.com>.

Brushes
The healing brush will now work on a separate, empty
layer. This means that you can do all your healing work on
a new layer and be able to easily remove or selectively
erase any healing brush or patch tool repairs that are
carried out. When the patch tool is used in Source mode, a
preview of the patch blend is displayed in the Source
selection area.

The color replacement brush is a new brush tool,
grouped with the patch tool and healing brush. It is an
effective tool for certain basic retouching tasks such as
reducing red eye from flash photographs.

Creating new documents
The New Document dialog contains new preset options
that are designed with video designers in mind. You can
select a preset size that matches the screen resolution of all
popular video formats and some of these also open with
preset guides. The View menu includes a Pixel Aspect
Ratio Correction option. This can be used to render a
scaled preview on the screen that more closely represents
the proportions of a video pixel display, that uses non
square pixels.

How do you do that?
Photoshop CS has many useful tips built-
in to the program. The Help menu is a
good starting point, from where you can
load the Welcome Splash screen, or
launch the Photoshop Help web document
or you can use the new ‘How To’ menus
and sub-menus to get instant help and
advice on a range of Photoshop issues.
The How Tos you see here are integrated
within Photoshop Help, but the How To
format is available for anyone to write their
own series of top tips for use in
Photoshop CS.

Figure 1.19     The color replacement brush is
ideal as a fast and effective tool for fixing red eye
in snap shots such as this.
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Type features
The type engine has undergone another overhaul.
Improvements have been made to improve compatibility.
One consequence of this is that when a text layered
document created in Photoshop 6.0 or 7.0 is opened in
Photoshop CS you will always see a warning requiring you
to update the text layers. In common with other Adobe
applications like InDesign, GoLive and Illustrator,
Photoshop CS uses a shared linguistic library for the
spelling library database. So if you update a word in the
spell checker in a recent version of one of the above
mentioned Adobe programs, the spelling update will be
shared with all other Adobe programs sharing the same
capability.

Type can be added to a pen path or vector shape so that
any type entered will follow along the path outline. Simply
move the type cursor close to the edge of the path to begin
adding the type. You can then edit the shape of the path to
change the shape of the type.

Overall impressions
Photoshop CS is bound to receive a mixed reception, which
is always the case with every new release of Photoshop.
There has certainly been an ongoing expectation that each
new version of the program should include a ‘killer
feature’. At first Photoshop CS may appear to lack exciting
new features such as the healing brush which was
introduced in version 7.0. But nonetheless this is another
important step forward in the evolution of Photoshop. As a
working photographer, the refinements made to the File
Browser, with its full integration of the Camera Raw plug-
in and the new Web Photo gallery feedback templates have
all significantly aided my production work flow. The
Shadow/Highlight image adjustment is another powerful
tool, which I can’t live without now.

Figure 1.19 Type can be added to an active
pen path by clicking anywhere near to the path
with any of the type tools. Type can also be made
to fill the interior of a shape vector path.

Illustration: Rod Wynne-Powell
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Adobe Photoshop CS for Photographers
This review of Adobe Photoshop CS is an extract from
Martin Evening’s forthcoming book: Adobe Photoshop CS
for Photographers, which will go on sale from early 2004.
This latest update in the Adobe Photoshop for
Photographers series will contain 576 pages in full color.
The book has been completely redesigned and contains
information and updated advice on everything you need to
know about using Photoshop, from digital capture to print
output, as well as all that is new in Adobe Photoshop CS!

To order the book
Adobe Photoshop CS for Photographers is published by
Focal Press, an imprint of Harcourt Education.

The title will be stocked in most major bookstores
throughout the UK and US and via many resellers
worldwide. It will also be available for purchase from:
www.focalpress.com and also through the on-line
bookstores: www.amazon.com and www.amazon.co.uk.


